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Who are our trainees?

❑ Universities - Postgraduate 

candidates and lecturers 

especially for those trained for 

Biostatistics, Epidemiology, public 

health, clinical medicine and 

laboratory based medicine 

disciplines

❑ Health personnel under disciplines 

of Medicine, Dentistry, Pharmacy 

and Allied health in universities 

and Ministry of Health

❑ Research institutes under National 

Institute of Health, Ministry of 

Health 

❑ Clinical Research Centres (CRCs) 

under Ministry of Health, Malaysia

❑ Pharmaceutical companies

❑ Non-governmental Organisations 

❑ Biostatisticians, Epidemiologists, 

public health personnel in 

Southeast Asia 
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SOME HIGHLIGHTS OF  

TEACHING STATA IN MEDICAL 

AND HEALTH SCIENCES 

RESEARCH



HIGHLIGHTS OF TEACHING 

STATA   

Data management
Types of study designs
Sample size determination
Examples of analysis



HIGHLIGHTS OF TEACHING 

STATA   

Data management



Types of files

 .dat

 .dta 

 .do 

 .ado 

 .hlp 

 .log

 .smcl

 .gph

 Tab-delimited files

 Data files

 Command files

 Programs files

 Help files

 Displayed in notepad (log file)

 Displayed in viewer window 

(formatted log file)

 Graphic files
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Import SPSS to Stata

Open SPSS dataset (exercise.sav)

SPSS Stata
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Import SPSS to Stata

Remember your file name and 

where you save the file!!!
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Import Excel to Stata

Excel Stata
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Import Excel to Stata

• Stata:

• File > Import > Excel spreadsheet (*.xls, *.xlsx)
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Open the file where you save 

your excel file
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Save as .dta file
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input

 input exposure disease number 

(code: 0/1 unexposed/exposed, 

0/1 no disease/disease)

 1 1 100

 1 0 30

 0 1 25

 0 0 70

 end

 tab exposure disease [fweight=number],chi2

 cc exposure disease [fweight=number]

Immediate command- 

tabi 100 30 \ 25 70, chi2

cci 100 30 25 70
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                               chi2(1) =    56.93  Pr>chi2 = 0.0000
                                                                   
 Attr. frac. pop           .6868132        
 Attr. frac. ex.           .8928571            .7938842     .944662 (exact)
      Odds ratio           9.333333            4.851641    18.07077 (exact)
                                                                   
                        Point estimate         [95% conf. interval]
                                           
           Total         125         100           225       0.5556
                                                                   
        Controls          25          70            95       0.2632
           Cases         100          30           130       0.7692
                                                                   
                     Exposed   Unexposed         Total      exposed
                                                         Proportion
. cc exposure disease [fweight=number]
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MANUAL DATA ENTRY IN 

STATA



Steps in Manual Data Entry

1. Create a new variable

2. Label a new variable’s name

3. Create a value label for a categorical variable (pseudo-

numeric)

4. Data entry
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Step 1: Create a new variable 

Data > Create or change data > Create new variable  
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Step 2: Label a new variable’s name 

Data > Variables Manager  OR  Click the icon        
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Step 3: Create values label

Click 

“Manage”
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Step 4: Data entry

Data > Data Editor > Data Editor (Edit)  OR Click the icon 
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Saving results by using log

 A log file is a record of your Result window

 It records all commands and all textual output

 Stata can save the file in one of two different 
formats:
 Stata Mark up and Control Language (SMCL) format

 Plain log file

Log button
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Saving results by using logs – two different 

formats

SMCL format

 Preserves all the formatting 

and links from Results 

window

 Can open these results in 

the Viewer 

 Will behave as though they 

were in the Results window

Plain log file

 Plain-text files without any 

formatting

 Can open by using notepad
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Saving results by using logs

Save as .smcl or .log file
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Saving results by using logs

 If you specify a file that already exists:
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View logs (.log file)
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Using the do-file editor

 Do-file → is a file containing a list of commands 

for Stata to run

New do-file editor

01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

29



Using the do-file editor

Highlighted the 

selected command > 

Send to Do-file editor
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Save the do-file

Save as .do file
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Using the do-file editor

• If you want to add command in do-file that already exists:

Copy the selected command 

and paste to the saved do-file
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Run the command using the do-file editor
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Execute (do)



Run the command using the do-file editor
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Highlight selected 

command

Run the command

1

2



HIGHLIGHTS OF TEACHING 

STATA   

Types of study designs



Overview of study designs

 Systematic review and meta analysis
 Interventional studies

 clinical trials & community trials

 Observational (Analytical) Studies
 Cohort studies 
◼ prospective, retrospective and historical

 Case-control studies 
◼ matched, unmatched and nested

 Cross-sectional studies 
◼ classical, comparative, diagnostic test, questionnaire

 Observational (Descriptive) studies
 population : prevalence, incidence studies 
 individuals: case reports, case series
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Parallel

Post-treatment assessment

test

Pre-treatment assessement

Post-treatment assessment

control

Pre-treatment assessement

Randomisation

Eligible subjects

Population
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Example

Post-treatment assessment

New drug

Pre-treatment assessment

Post-treatment assessment

Usual drug

Pre-treatment assessment

Randomization

Eligible subjects

Hypertensive Patients
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Cross-over

Test control

Control Test

Outcome assessment

Outcome assessment

Randomization

Eligible subjects

Population
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Cross-over

Post-treatment assessment

Placebo

Pre-treatment assessment

Wast-out period

Post-treatment assessment

New treatment

Pre-treatment assessment

Post-treatment assessment

New treatment

Pre-treatment assessment

Wash-out period

Post-treatment assessment

Placebo

Pre-treatment assessment

Randomization

Eligible subjects
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Design of  a Prospective Cohort Study

EXPOSED

UNEXPOSED

Direction of  Inquiry

+ Disease

No Disease

- Disease

+ Disease
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Design of  a Retrospective 

   Cohort  Study 

EXPOSED

UNEXPOSED

Direction of  Inquiry

+ Disease

No Disease

- Disease

+ Disease
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Design of a Case-Control study

CASES

Controls

EXPOSED

UNEXPOSED

EXPOSED

UNEXPOSED

Direction of  Inquiry
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Exposed Disease 

Not exposed
No disease

Population



Sample 

Observation 
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Exposed Disease 

Not exposed
No disease

Population 1



Sample 1 

Observation 

Population 2

Sample 2 



RR OR

IRR/ OR
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HIGHLIGHTS OF TEACHING 

STATA   

Sample size determination



Estimated sample size for two samples with repeated measures
Assumptions:
                                      alpha =   0.0500  (two-sided)
                                      power =   0.9000
                                         m1 =       25
                                         m2 =       20
                                        sd1 =        5
                                        sd2 =       10
                                      n2/n1 =     1.00
           number of follow-up measurements =        3
 correlation between follow-up measurements =    0.500
            number of baseline measurements =        0

Method: POST
 relative efficiency =    1.500
    adjustment to sd =    0.816
        adjusted sd1 =    4.082
        adjusted sd2 =    8.165

 Estimated required sample sizes:
                  n1 =       36
                  n2 =       36
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HIGHLIGHTS OF TEACHING 

STATA   

Examples of analyses 



A general guide to select appropriate statistical methods in multivariable and multivariate 

analyses 

 
Number 

of dependent 

variables 

Independent variables Dependent variable Statistical test 

One  

(Multivariable 

univariate) 

Numerical and categorical 

Numerical and categorical 

Numerical and categorical 

Numerical and categorical 

Numerical and categorical 

Numerical and categorical 

Factors and covariates 

 

One factor 

Two factors  

Three and more factors 

Factors (with controlled covariates 

and factors) 

 

Numerical  

Categorical (dichotomous) 

Categorical (polytomous-nominal) 

Categorical (ordinal) 

Categorical (matched) 

Time to event  

Count/ Rate 

 

Numerical  

Numerical 

Numerical 

Numerical 

 

 

- Multiple Linear Regression 

- Multiple/ Binary Logistic Regression 

- Multinomial Logistic Regression 

- Ordinal Logistic Regression 

- Conditional Logistic Regression 

- Cox Proportional Hazards Regression  

- Loglinear Regression/ Poisson Regression 

 

- a One-way ANOVA 

- Two-way ANOVA 

- Multi-factorial ANOVA 

- ANCOVA 

 

 

More than one 

(Multivariable 

multivariate) 

Factors 

Factors (with controlled covariates 

and factor)  

Factors  

Factors (with controlled covariates 

and factors) 

Factors 

Factors (with controlled covariates 

and factors) 

 

Factors and covariates 

 

Numerical 

Numerical 

 

Numerical (repeated measures) 

Numerical (repeated measures) 

 

Numerical (repeated measures) 

Numerical (repeated measures) 

 

 

Categorical (repeated measures) 

 

- MANOVA 

- MANCOVA 

 

- Repeated Measures ANOVA 

- Repeated Measures ANCOVA 

 

- Repeated Measures MANOVA 

- Repeated Measures MANCOVA 

 

 

- Cross-sectional Time Series (Xt) 

 
a One independent variable only 



STEPS IN ADVANCED SURVIVAL ANALYSIS
1. Data exploration and cleaning

2. Univariable analysis (Simple Cox Regression)

3. Variables selection (Multiple Cox Regression) → Preliminary main effect model

4. Checking linearity of continuous variable

5. Checking multicollinearity and interactions → Preliminary final model

6. Checking the specification error of preliminary final model

7. Checking the assumption of the model 

8. Regression diagnostic

→ Cox-Snell residual → Deviance residual

→ Martingale residual → Influential analysis

9. Remedial measures → Final model

→ Change of regression coefficient

If change is < 20% → not influential

If change is ≥ 20% → influential

10. Interpretation, conclusion and presentation
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Graphs Tests

Hazard function plot Scaled Schoenfeld (Separate test)

Log Minus Log plot Unscaled Schoenfeld (Global test)

Schoenfeld residual (partial residual) C-statistics



Step 3: variables selection 

(multiple cox regression)
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Backward Stepwise Method
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Step 4: checking linearity of 

continuous variable
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Multivariable Fractional Polynomial (mfp

command)

 Statistics > Linear models and related > Fractional 

polynomials > Multivariable fractional polynomial models
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 Based on the results, there is no 

significant difference in comparing linear 

model to the best two-term fractional 

polynomial model 

 Thus, we can treat variables pathsize 

and lnpos as linear in the model01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

57



Step 7: checking the 

assumption of the model
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Graphs Tests

Hazard function plot

- For categorical variable

Scaled Schoenfeld

(Separate test)

Log Minus Log plot

- For categorical variable

Unscaled Schoenfeld

(Global test)

Schoenfeld residual 

(partial residual)

- For both numerical and 

categorical variables

C-statistics



 There was no evidence that the 

proportional hazards assumption has 

been violated
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Separate test

Global test

Partial likelihood estimate 

of regression coefficient
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There was no evidence that the proportional 

hazards assumption has been violated

Separate test

Global test



C-statistics

 Harrell’s C or C-statistics – as the proportion of all pairs in 

which the predictions and outcomes were concordant

 0.5 and below → no discrimination

 0.7 – 0.8 → acceptable discrimination

 0.8 – 0.9 → excellent discrimination

 0.9 and above → outstanding discrimination
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command: 

• stcox  [independent]

• estat concordance



01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing
63

 The model was able to discriminate between 

those who experienced the event versus those 

who did not by 72.7%

 It indicated the concordance between predicted 

and observed values of outcome was 72.7% in 

the preliminary final model



Regression diagnostic

 Cox-Snell residuals

 Martingale residuals

 Deviance residuals

 Influence analysis
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Cox-Snell Residuals

 Assessing overall model fit

 Determining whether Cox regression model fits the data well

 If the Cox regression model fits the data, residuals should have a standard 

censored exponential distribution with hazard ratio 1

 Verification of the model’s fit – calculate estimate of cumulative hazard 

function (using Cox-Snell residuals as the time variable and the data’s 

original censoring variable)

 If the model fits the data, the plot of the cumulative hazard versus Cox-Snell 

residuals should be a straight line with slope 1
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0
.5

1
1

.5
2

0 .5 1 1.5 2
Cox-Snell residual

H Cox-Snell residual

 Comparing the jagged line with reference line, it is 

interpreted that Cox regression model fits 

relatively well



Martingale Residuals

 Determining the functional form of covariates to be included in 

the model

 Assessing lack of fit

 Determining whether the transformation is necessary

 The difference over time of the observed number of failures 

minus that predicted by the model
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 Martingale residuals against positive 

axillary lymph nodes
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Step 9: remedial 

measures

71
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Remedial measures

 Percent changes in regression coefficient ≥ 

20%

 Command:

 stcox [independent]

 stcox [independent] if n!=9
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Variables Regression 

coefficient (b)

Adjusted Hazards

Ratio (95% CI)

P-value

pathsize 0.45 1.57 (1.21, 2.03) 0.001

lnpos 0.14 1.15 (1.05,1.26) 0.004

pr

Negative

Positive

0

-0.67

1

0.51 (0.26, 0.99) 0.045

Table 1: Prognostic factors of breast cancer

Backward stepwise Cox proportional hazards regression model applied.

Multicollinearity and interactions were unlikely.

The preliminary final model was properly specified.

Hazard function plot, Log-minus-log plot, Schoenfeld partial residuals plot, 

scaled and non-scaled Schoenfeld residuals test and C-statistics were 

applied to check the assumption of the model.

Regression diagnostics were performed by Cox-Snell residual, Martingale 

residual, deviance residual and influential analysis.

Influential outliers were identified by checking percent changes in regression 

coefficient set at 20%.



Steps in ordinal logistic regression

1) Data exploration and cleaning

2) Univariable analysis

3) Variables selection

4) Checking linearity of continuous variables 

5) Checking multicollinearity and interactions

6) Checking the specification error of preliminary final 
model

7) Checking assumptions

8) Checking overall fit of the model

9) Regression diagnostic (outliers and influential)

10)Remedial measures

11)Data interpretation, conclusion and presentation
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Step 4: Checking linearity of 

continuous variable

 Need to check the scale of continuous variable 

by using three separate binary regressions of 

y=k vs. y=0

 Linearity checking by using:

Multivariable fractional polynomial (mfp command)

 lintrend command  

 design variable
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 Second binary logit model

Deviance

Dev. diff

P-value

Power 
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 Third binary logit model

Deviance

Dev. diff

P-value

Power 



Step 6: Checking the specification error 

of preliminary final model

 Command “linktest” is used to detect a specification error

 The link test is based on the idea of if the model is 
properly specified, any additional independent variables 
that are statistically significant should not be found except 
by chance

 The link test uses the linear predicted value (_hat) and 
linear predicted value squared (_hatsq)

 _hat should be statistically significant as it was predicted 
value from the model

 _hatsq should not be statistically significant in order for the 
link function to be correctly specified
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 Run the preliminary final model

 Run the linktest

 The model was properly specified
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command: 

ologit [dependent] [independent]

linktest



Proportional odds assumption

 omodel can be used to perform a test of the 

assumption of constancy of effects across 

categories assumed in models fitted by ologit

 omodel reports an approximate likelihood-ratio test 

of whether the coefficients are equal across 

categories (test of the proportional odds 

assumption) 

 omodel command is not available in Stata by 

default, need to install by using 
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command: findit omodel
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command: omodel logit [dependent] [independent]



Parallel regression assumption

 brant performs a Brant test of the parallel 

regression assumption after ologit

 It reports both the results of an omnibus test for 

the entire model and tests of the assumption for 

each of the independent variables in the model

 brant command is not available in Stata by 

default, need to install by using 

01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

82

command: findit brant
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command: ologit [dependent] [independent], nolog or

  brant, detail

Result for the 

entire model

Results for each 

of the 

independent 

variables in the 

model

The parallel regression 

assumption is met



 The tests indicate that the assumptions are not 

violated

 If the assumptions are violated, need to run 

model as a generalized ordered logistic model 

using gologit2

 gologit2 is not available in Stata by default, 

need to install by using 
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command: findit gologit2



Step 8: Checking overall fit of the 

model

 Need to performed three separate full 

assessments of fit based on the binary logistic 

regressions of bwt4n=k vs. bwt4n=0

 Hosmer-Lemeshow test

 Pearson Chi-square Goodness of fit test computed 

by covariate pattern

 Stukel’s test (not available in Stata)

 Classification table

 Area under the ROC curve
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Hosmer-Lemeshow test

 It is based on grouping cases into 10 groups 

 It compares the observed probability with the expected 
probability within each group

 Check the P-value. If it is >0.05, there is no significant 
difference between the observed probability and the expected 
probability. Thus, assumption is met

 Run the regression model separately for each binary logit
model

 Statistics > Binary outcomes > Logistic regression, 
reporting coefficients
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 The p-value is >0.05, which is 0.892

 We can conclude that the model is fit
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command: estat gof, group(10)



Pearson Chi-square Goodness of fit test
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 The p-value is >0.05, which is 0.229

 We can conclude that the model is fit

command: estat gof



Classification table

 Overall correctly 

classified 

percentage is 

good if above 

70%

91
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command: estat classification



Area under the ROC curve

 Ranges from 0 to 1

 Able to assess the model discrimination

 A value of 0.5 means the model is useless for 

discrimination

 The recommended area under the ROC curve is at least 

0.70

 Values near to 1 is better
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Double click ROC curve 

and area under ROC 

curve

1st method: Using lroc command

Disadvantage: 95% CI is not provided
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 Area under the 

ROC curve is 0.638

 It is significantly 

different from 0.5 

 The model can 

accurately 

discriminate 63.8% 

of the cases
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command: lroc

0
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0
0
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.0
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S
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n
s
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iv

it
y

0.00 0.25 0.50 0.75 1.00
1 - Specificity

Area under ROC curve = 0.6380

*Repeat for second and third binary logit model
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Click Predictions.

Then double click 

Probabilities, influence 

statistics, residuals, etc.

Create predicted value

2nd method: Using roctab command

Advantage: 95% CI is provided
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command: 

predict predicted, p
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Create ROC curve

Graphics > ROC analysis > Nonparametric ROC curve
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0
.0

0
0

.2
5

0
.5

0
0

.7
5

1
.0

0

S
e

n
s
it
iv

it
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0.00 0.25 0.50 0.75 1.00
1 - Specificity

Area under ROC curve = 0.6380

*Repeat for 

second and third 

binary logit model



 As a conclusion:
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1st binary logit

model

2nd binary logit

model

3rd binary logit

model

Hosmer-Lemeshow

test

P=0.892 P=0.686 P=0.186

Pearson chi-square 

test

P=0.229 P=0.144 P=0.216

Classification table: 

Overall correctly

classified percentage

63.9% 64.8% 71.4%

Area under the ROC 

curve

0.64 

(95% CI: 0.52, 

0.75)

0.69

(95% CI: 0.58, 

0.79)

0.85 

95% CI: 0.78, 

0.93



Step 9: Regression diagnostic

(outliers & influential)

 Before concluding that the model “fits”, need to see if fit 

is supported over the entire set of covariate pattern

 Estimated logistic probability (p)

 Leverage (h)

 Covariate pattern (n)

 Hosmer and Lemeshow Delta chi-squared influence statistic 

(dx2)

 Hosmer and Lemeshow Delta-D influence statistic (dd)

 Pregibon Delta-Beta influence statistic (db)
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 Need to perform three separate full assessments of fit 

based on the binary logistic regressions of bwt4n=k vs. 

bwt4n=0
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command: logit [dependent] [independent] if [condition is fulfilled]
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 Statistics > Postestimation 

Click Predictions.

Then double click Probabilities, 

influence statistics, residuals, etc
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*Repeat for 

-Leverage (h)

-Covariate pattern (n)

-Delta chi-squared influence statistic (dx2)

-Delta-D influence statistic (dd)

-Delta-Beta influence statistic (db)

command: predict [new variable name], p/hat/n/dx2/ddeviance/dbeta
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 First binary logit model

 Second binary logit model

 Third binary logit model



 Graphical presentation for each binary logit 

model

 Scatter plot of dx2 vs p

 Scatter plot of dd vs p

 Scatter plot of db vs p

 Scatter plot of h vs p

 Scatter plot of dx2 vs p weighted with db (This plot 

allows us to ascertain the contributions of residual 

and leverage to db. The larger circle corresponds to 

the larger value of dx2)
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command: scatter [y-axis] [x-axis], mlabel(covariate pattern)

      scatter [dx2] [p] [w=db], msymbol(oh)



 How to determine outliers?

 From the scatter plot, observe the cases with different 

covariate pattern that largely deviates from other cases

 Delta Beta influential statistics (db) > 1

 Delta D influential statistics (dd) > 4

 Delta Chi-squared influential statistics (dx2) > 4

 Leverage > 0.5

01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

109



01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

110

41

55

79

21

2
70

11

54

61
75

20

53358
669
81

73

19
52

3

17

30
35

62

59
43

57

60

1

28

21

2667
29

44

15

10
18

27

79

482234
39

65

56

38

28

42

71

21

80

16

8

15

7

66

5678

74

20

252351

36

19

4931

9

70

9

24

1414

12

37

40

38

45

13 82

39

40

76

47

68

77

3232

4

46

72

53

646350

0
2

4
6

H
-L

 d
X

^
2

0 .2 .4 .6 .8
Pr(bwt4n)

41

55

79

21

2

70

11

54

61
75

20

53358

669

81

73

19

52
3

17

30
35

62

59

43

57

60

1

28

21

2667
29

44

15

10
18

27

79

482234

39

65

56

38

28

42

71

21

80

16

8

15

7

66

56

78

74

20

252351

36

19

4931

9

70

9

24

1414

12

37

40

38

45

13 82

39

40

76

47

68

77
3232

4

46

72

53

646350

0
2

4
6

H
-L

 d
D

0 .2 .4 .6 .8
Pr(bwt4n)

41

55
79

21

2 7011

54

61
75

20

5

3358
669

81

73
1952 3

17

30
35

62

59
43 57

60

1

28

21

266729 44

15

10 18

27

79

482234 39 65

56

38

28 42

71

21

80

16
8

15

7

6656

78

74

20

2523

51

36
19

4931

9

70

9

24

1414

12

37

40

38

45
13 82

39

40

7647 68

77

3232

4

46

72

53

646350

0
.2

.4
.6

.8

P
re

g
ib

o
n

's
 d

b
e

ta

0 .2 .4 .6 .8
Pr(bwt4n)

0
2

4
6

H
-L

 d
X

^
2

0 .2 .4 .6 .8
Pr(bwt4n)

First binary logit model



01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

111

39
49

80

18

2

69

11
48

58

76

17
6 31

52

7

6884
73

16
45 4

14

28
34

62

5341 51551

23

18

21

67

26 42

12

1015
22

80

4419 32
3865

50
37

23

40

72

18
83

139

12

8
66

50 85

20
79

81

54

75

55

57

58

30

3

3647

509 31

24

25

71
16

353535
24

6359
77

31 87

64
74

27
70

33
29

61

86

6360

43

82
56

78

24

46

0
5

1
0

1
5

H
-L

 d
X

^
2

.2 .4 .6 .8
Pr(bwt4n)

39

49

80

18

2

69

11

48

58

76

17

6 31

52

7

6884
73

16

45
4

14

28

34

62

5341 51
55

1

23

18

21

67

26 42

12

10
15

22

80

4419

32

3865

50

37

23

40

72

18

83

13

9

12

8

66

50

85

20
79

81

54

75

55

57

58

30

3

3647

50
9 31

24

25

71

16

353535

24

63
59

77

31 87

64
74

27

70

33

29

61

86

63

60

43

82

56

78

24

46

0
2

4
6

8

H
-L

 d
D

.2 .4 .6 .8
Pr(bwt4n)

39
49

80

18

2
69

11 48
58

76
176 31 527 68

84

73
16

45 4
14

28 34
62

5341 51551

23

18

21
67

26 42

12

1015
22

80

4419 32 38655037
23

40 72

18

83

139

12

8
66

50 8520

79

81

54

75

55

5758
30

3

3647509 31

2425

7116

353535
24

63
59

77

31 87

64
74

27 7033

29

61 86
63

60

43

8256 78

24

460
.5

1
1

.5
2

P
re

g
ib

o
n

's
 d

b
e

ta

.2 .4 .6 .8
Pr(bwt4n)

0
5

1
0

1
5

H
-L

 d
X

^
2

.2 .4 .6 .8
Pr(bwt4n)

Second binary logit model



01/02/2024    Oceania Stata Conference 2024    Nyi Nyi Naing

112

37

49

81 182

67

11 46
55

73

174
28

525
66

83

70
1645 3

14

26
32

61

5339 51541
22

18
20

65

24 40
12

1015 21814119 29
35 62

50

34

22
38

69

18

82

13 7
12

6 63 50

43

36

18 48 784456

57

84

8

59

58 68

6464

602179

23

21
35

8525 74

34
77

80

35

50

31
76

57

5852
33

9

71
72 27 474833

75

34

30420
5

1
0

1
5

2
0

H
-L

 d
X

^
2

0 .2 .4 .6 .8 1
Pr(bwt4n)

37

49

81

182

67

11
46

55

73

17

4

28

52

5

66

83

70

16

45
3

14

26

32

61

5339
51

541

22

18

20

65

24
40

12

1015

21
81

4119
29

35

62

50

34

22

38

69

18

82

13

7

12

6

63

50

43

36

18

48

78
4456

57

84

8

59

58

68

6464

6021

79

23

21

35
85

25

74

34

77

80

35

50

31

76

57

58

52

33

9

71

72

27
47

48
33

75

34

3042

0
2

4
6

H
-L

 d
D

0 .2 .4 .6 .8 1
Pr(bwt4n)

37

49

81
182

67

11
46 55

73

174
28

525

66
83

70

1645 3

14

26 32

61

5339 51541

22

1820

65

24 40

12

1015
2181

4119 29

35

62
50

34

22

38

69

18

82

13 7

12

6

63

50

43

36

18 48
784456

57

84

8

59

58
68

6464

60

2179
23

21

35 85

25 74

34

77

80

35

50

31

76

57

58
52

33

9

71

72
27 47

4833
75

34

30420
.2

.4
.6

.8
1

P
re

g
ib

o
n

's
 d

b
e

ta

0 .2 .4 .6 .8 1
Pr(bwt4n)

0
5

1
0

1
5

2
0

H
-L

 d
X

^
2

0 .2 .4 .6 .8 1
Pr(bwt4n)

Third binary logit model



Checking influential statistics & leverage

 For first binary logit model, only dx1>4 and dd1>4 for the cases with 

covariate pattern of 9 and 40
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command: list [prediction] if [condition is fulfilled]

First binary logit model



 For second binary 

logit model, dx2>4, 

dd2>4 and db2>1 

for the cases with 

covariate pattern of 

5, 18, 24, 25 and 35
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Second binary logit model

Third binary logit model
 For third binary logit 

model, dx3>4 and 

dd3>4 for the cases 

with covariate 

pattern of 8, 36 and 

61



Step 10: Remedial Measures

 Percent changes in regression coefficient ≥ 20%
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command: logit [dependent] [independent] if [condition is fulfilled]

command: logit [dependent] [independent] if [condition is fulfilled] & n2!=25 



Percent changes in regression coefficient
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For covariate pattern 25 in second binary logit model

With outlier

Without outlier



Variable Percent changes (%)

lwt 1.88

race1 4.83

race2 96.83

smoke 25.33

ui 32.12
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Table 3: Percent changes in regression coefficient for 

each variable in for covariate pattern 25

 From the table, percent changes in variable race, smoke 

and ui were more than 20%

 It is high possibility that the observations with covariate 

pattern 25 are influential outlier

 Decision to remove the cases depends on the 

researcher



Step 11: Interpretation, conclusion 

and presentation

 Run final regression model
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command: ologit [dependent] [independent] if [condition is fulfilled], nolog or
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Variables Regression 

coefficient (b)

Adjusted Odds Ratio 

(95% CI)

p-value

lwt 0.01 1.01 (1.003, 1.021) 0.009

race

white

black

others

0

-1.52

-0.94

1

0.22 (0.097, 0.498)

0.39 (0.206, 0.747)

<0.001

0.004

smoke

no

yes

0

-1.09

1

0.34 (0.184, 0.615) <0.001

ui

no

yes

0

-0.96

1

0.38 (0.177, 0.820) 0.014

Table 4:  Associated factors of heavier versus a lighter birth weight 

babies



Footnote:

 Backward stepwise logistic regression was applied

 Linearity of continuous variable was checked and reported to be linear

 Multicollinearity and interactions were unlikely

 Assumptions of similarity between proportional model and unconstrained 
baseline logit, proportional odds assumption and parallel regression 
assumption were checked and found to be fulfilled

 Overall fit of the model was checked and reported to be Hosmer-
Lemeshow test (first model: p=0.892; second model: p=0.686; third 
model: p=0.186), Pearson chi-square test (first model: p=0.229; second 
model: p=0.144; third model: p=0.216), correctly classified percentage
(first model: 63.9%; second model: 64.8%; third model: 71.4%), Area 
under the ROC curve (first model: 0.64 (95% CI: 0.52, 0.75); second 
model: 0.69 (95% CI: 0.58, 0.79) ; third model: 0.85 (95% CI: 0.78, 0.93))

 Regression diagnostic was performed by estimated logistic probability
(p), Leverage (h), covariate pattern (n), Hosmer and Lemeshow Delta chi-
squared influence statistic (dx2), Hosmer and Lemeshow Delta-D 
influence statistic (dd) and Pregibon Delta-Beta influence statistic (db)

 Influential outliers were identified by checking percent changes in 
regression coefficient set at 20%
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Interpretation & conclusion

 The estimate of the OR for a heavier versus lighter 

weight baby with black mothers compared to white 

mothers was adjusted OR=0.22 (95% CI 0.097, 0.498), 

P<0.001. The odds of a heavier versus lighter weight 

baby was 78% less for black mothers compared to white 

mothers

 The estimate of the OR for a heavier versus lighter 

weight baby with mothers of other races compared to 

white mothers was adjusted OR=0.39 (95% CI 0.206, 

0.747), P=0.004. The odds of a heavier versus lighter 

weight baby was 61% less for mothers of other races 

compared to white mothers
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Interpretation and conclusion

 The estimate of the OR for a heavier versus lighter 
weight baby with mother who smoked compared to 
those who did not smoke was adjusted OR=0.34 (95% 
CI 0.184, 0.615), P<0.001. The odds of a heavier versus 
lighter weight baby was 66% less for smoking mothers 
compared to non-smoking mothers

 The estimate of the OR for a heavier versus lighter 
weight baby with mothers with uterine irritability 
compared to mothers without uterine irritability was 
adjusted OR=0.38 (95% CI 0.177, 0.820), P=0.014. The 
odds of a heavier versus lighter weight baby was 62% 
less for mothers with uterine irritability compared to 
mothers without uterine irritability
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Interpretation and conclusion

 95% confidence interval of adjusted OR=1.01 does not 

include one (1.003, 1.021), variable weight of mother is 

significant to the model (P=0.009). There is a 1% 

increase in the odds of a heavier baby per one pound 

increase in weight of mother
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